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Nyheter
Nyheter i version 5.3 för programvaran TI Connect™ CE
TI CE-paketfil – använd en datorfil för att uppdatera din CE-räknare!

Uppdatera din(a) anslutna CE-räknare med ett steg med hjälp av TI Connect™ CE och
nya TI CE-paketet hämtat från education.ti.com. Detta är ett alternativt sätt att
uppdatera din räknare med ett steg.

Se mer

Programeditor
HUB- meny för TI-Innovator™ och TI-Innovator™ Rover

Programredigeraren stöder HUB-menyn för TI-Innovator™ för TI-Innovator™ och TI-
Innovator™ Rover-kommandon. HUB-menyn finns i programmenyn i katalogträdet.

Se mer

Nytt kommando

• styckvis-kommandot (piecewise) har lagts till katalogträdet för TI Connect™ CE i
Math>MA och även i katalogen. Detta kommando stöder ny mall för plottning av
styckvisa funktioner i CE OS 5.3.

För mer information om nya och uppdaterade kommandon, gå till referensguiden för
TI-84 Plus CE-T på education.ti.com/go/download.

Nyheter 1
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2 Introduktion till TI Connect™ CE-programvaran

Introduktion till TI Connect™ CE-programvaran
Med TI Connect™ CE-programvaran kan du snabbt och lätt utbyta information mellan
din grafräknare och din dator.

Stöder alla TI grafräknare-8x familj med USB-port, vilket inkluderar:

• TI-84 Plus CE

• TI-84 Plus CE-T

• TI 84 Plus C Silver Edition

• TI-84 Plus

• TI-84 Plus T

• TI-83 Premium CE

• TI-83 Plus.fr

• TI-82 Advanced

Anmärkning: Använd TI Connect 4.0 som stöder räknare med endast en I/O-port:

• TI-83 Plus

• TI-89 Titanium

• Voyage 200

• TI-73 Explorer



Använda TI Connect™ CE Software
TI Connect™ CE Software innehåller verktyg som du kan använda för att utbyta
information mellan din räknare och din dator.

TI Connect™ CE-programvaran har tre arbetsområden:

• Screen Capture (Infånga skärmbild): här kan du hantera infångade skärmbilder.

• Calculator Explorer (Räknarutforskare): här kan du hantera räknarens innehåll.

• Program Editor (Programeditor): här kan du hantera TI grundläggande program.
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4 Använda TI Connect™ CE Software

Områden i TI Connect™ CE Software

Menyrad - Använd dessa menyer för att hantera räknarfiler och skärmar för
att visa räknarinformation och för att få hjälp.

Verktygsfält - Använd dessa ikoner för att hantera datorfiler och skärmar.

Arbetsområdespanel - Använd denna panel för att välja arbetsområden (Screen
Capture (Infånga skärmbild), Calculator Explorer (Räknarutforskare) och
Program Editor (Programeditor)).

Räknarlistpanel - Använd denna lista för att visa alla anslutna räknare och
välja en räknare för visning.



Innehållspanel - Använd denna panel för att visa och hantera räknarfiler och
skärmar i anslutna räknare.

Anmärkning: Du kan utföra de flesta åtgärder på dessa menyer genom att dra
och släppa poster till din anslutna räknare eller dator.

Använda TI Connect™ CE Software 5



6 Använda arbetsområdet Screen Capture (Infånga skärmbild)

Använda arbetsområdet Screen Capture (Infånga
skärmbild)
I arbetsområdet Screen Capture kan du hantera infångade skärmbilder.



Delar av Screen (Infånga skärmbild) Arbetsyta
Menyrad - Använd dessa menyer för att hantera filer och bilder, visa räknarinformation
och för att få hjälp.

Anmärkning: Du kan utföra de flesta åtgärder på dessa menyer genom att dra och
släppa poster från Innehållspanelen.

Verktygsfält - Klicka på dessa ikoner för att spara, skicka, kopiera, ta bort och ändra
storleken på filer.

Spara en fil till datorn.

Skicka en fil till en räknare.

Kopiera en fil.

Ta bort en fil.

Lägg till och ta bort en ram runt alla skärmbilder.

Ändra storlek på alla skärmbilder.

Visa skärmbildens storlek.

Innehållspanel - Visa skärmbilder i Innehållspanelen.

Infånga och använda skärmar
Från arbetsområdet Screen Capture (Infånga skärmbild) kan du infånga och visa
skärmar från din räknare.

Innan du börjar

Anslut räknaren till datorn och se till att den visas i Räknarens lista Panelen.

Använda arbetsområdet Screen Capture (Infånga skärmbild) 7



8 Använda arbetsområdet Screen Capture (Infånga skärmbild)

Infånga skärmbilder från räknare

1. I arbetsområdespanelen för TI Connect™ CE Software, klicka på arbetsområdet
Screen Capture (Infånga skärmbild).

2. Visa skärmen på den räknare som du vill infånga.

3. Klicka på intill önskad räknare i Calculator List Panel (Räknarlistpanel).

• Om mer än en räknare är ansluten, klicka på bredvid an CONNECTED
CALCULATORS (Anslutna räknare) för att infånga skärmar från alla räknare.

Spara räknarskärmar som filer
Från arbetsområdet Screen Capture (Infånga skärmbild) kan du spara infångade eller
befintliga bilder från din räknare som en PNG-fil.

Anmärkning: Asterisken i början av ett bildnamn indikerar att bilden inte har sparats.

Spara en befintlig skärm

1. Klicka på den infångade skärmen i Innehållspanelen.

2. Klicka på .
För att spara flera skärmbilder

1. Klicka på Edit > Select All (Redigera > Välj alla).

2. Klicka på .
Ändra namn på en skärmbild

1. Placera markören i början av skärmnamnfältet.
Exempel: Capture 1 (Skärmbild 1).

2. Dubbelklicka på namnet för att välja det.

3. Skriv in ett nytt namn på datorfilen.

Spara en ny skärmbild som en PNG-fil

1. Klicka på bilden.

2. Klicka på .



3. Navigera till önskad plats där bilden ska sparas.

4. Använd standardfilnamnet eller skriv in ett nytt filnamn.

5. Klicka på .

Skicka skärmbilder till anslutna räknare

Funktionen "Screen Capture Only" erbjuder ett sätt att ta en skärmbild av en graf på de
högupplösande räknarna, beskära grafområdet och sedan bara konvertera grafområdet
till en Bakgrundsbild. Markera Graph Area Only för att skapa denna typ av
Bakgrundsbild.

1. Infånga skärmbilden om du inte redan har gjort detta.

2. Klicka på skärmbilden för att välja den.

3. Klicka på

• FILE NAME (Filnamn): Detta kan skilja sig från NAME ON CALCULATOR beroende på
vilket namn du har gett skärmbilden på din dator.

• NAME ON CALCULATOR (Räknarens namn): Välj bakgrundsbilden (detta bör vara
standardbilden, men du kan ändra bakgrundsbildens namn på denna meny).

Anmärkning: Skärmbilder och konverterade bildfiler skickas som Pic Vars till i
gråskala räknare.

• GRAPH AREA ONLY (Endast grafområde): I den högra panelen, välj huruvida du
endast vill skicka grafområdet eller hela skärmen. När du skickar en skärmbild
tillbaka till en räknare är det bäst att endast skicka grafområdet.

Beskära en bild

En skärmbild av grafområdet innehåller helskärmsbilden av TI-84 Plus CE,
statusfältet, graframen och grafområdet.

Använda arbetsområdet Screen Capture (Infånga skärmbild) 9



10 Använda arbetsområdet Screen Capture (Infånga skärmbild)

Med TI Connect™ CE-programvaran kan du beskära bilden till en Graph Area Only-
storlek för att skapa en Background Image Var. Du kan beskära en skärm till Graph
Area Only i dialogrutan Send to Calculators (Skicka till räknare).

• DESTINATION CALCULATORS (Mottagande räknare): Välj huruvida du vill skicka
bilden till alla anslutna räknare eller till endast valda räknare (från en checklista).

Skicka filer till flera räknare

1. Välj knappen Select Calculators (Välj räknare) i dialogrutan.

2. Markera rutorna intill de räknare som du vill välja.

3. Klicka på Send (Skicka).

Dra och släppa infångade skärmar till datorapplikationer
Från arbetsområdet Screen Capture (Infånga skärmbild) kan du dra och släppa
infångade skärmar till många datorapplikationer. Med denna funktion kan du använda
räknarskärmar i dina dokument.

Dra och släppa skärmar i datorapplikationer

1. Öppna eller infånga skärmen.

2. Dra och släpp skärmen till ett öppet dokument eller en datorprogramapplikation.

Obs: Du kan också använda Redigera> Kopiera> Klistra in i ett öppet dokument eller
presentatör datorprogrammet .



Använda arbetsområdet Calculator Explorer
(Räknarutforskare)
Från arbetsområdet Calculator Explorer kan du hantera räknarens innehåll.

Använda arbetsområdet Calculator Explorer (Räknarutforskare) 11



12 Använda arbetsområdet Calculator Explorer (Räknarutforskare)

Delar av Calculator Explorer (Räknarutforskare) Huvud arbetsyta
Menyrad - Använd dessa menyer för att hantera filer och bilder, visa räknarinformation
och för att få hjälp.

Anmärkning: Du kan utföra de flesta åtgärder på dessa menyer genom att dra och
släppa poster från Innehållspanelen.

Verktygsfält - Klicka på dessa ikoner för att lägga till, överföra eller ta bort filer från din
räknare.

Lägg till innehåll från din dator.

Skicka valt innehåll till din dator.

Skicka valt innehåll till en annan ansluten räknare.

Ta bort den valda filen.

Uppdatera vyn av en ansluten räknares innehåll.

Innehållspanel - Välj filer som du vill hantera från denna panel.



Välja en ansluten räknare
Med TI Connect™ CE-programvaran kan du ansluta flera räknare samtidigt. Klicka på
den räknare som du vill arbeta med för att välja den. Den valda räknaren blir
standardräknare för alla åtgärder i TI Connect™ CE-programvaran.

Innan du börjar

Anslut räknaren till datorn och se till att den visas i Räknarens lista Panelen.

Kopiera räknarfiler till datorn
Du kan kopiera de flesta data, filer och program från din räknare till din dator som en
"innehålls-backup", för att skicka denna till andra räknare eller för att frigöra minne i
räknaren.

Kopiera en fil från räknaren till datorn

1. Klicka på filnamnet för att välja det.

2. Dra och släpp filen i en mapp i din dator eller på ditt skrivbord.

För att kopiera en fil från räknaren till datorn som ett innehåll backup

1. Välj Redigera

2. Välj alla

3. Dra och släpp filen i en mapp på datorn eller på skrivbordet.

Obs: Det finns ingen automatisk backup funktion här.

Varning: Koppla inte loss kabeln under en överföring.

Använda arbetsområdet Calculator Explorer (Räknarutforskare) 13



14 Använda arbetsområdet Calculator Explorer (Räknarutforskare)

Kopiera en fil från datorn till räknaren

1. Navigera till önskad fil i din dator.

2. Dra filen till Räknarlistpanelen och håll den över önskad räknare.

3. Släpp musknappen när du ser .
4. Välj ett filnamn på rullgardinsmenyn. Detta blir filens namn i din räknare.

5. Klicka på Send (Skicka).

Skicka filer till anslutna räknare
Du kan skicka filer till räknare som är anslutna till TI Connect™ CE-programvaran.

Varning: Koppla inte loss kabeln under en överföring.

Skicka filer till anslutna räknare

1. Klicka på filen (s) i innehållspanelen för att välja den.

2. Klicka på .

• DESTINATION CALCULATORS (Mottagande räknare): Välj huruvida du vill skicka filen
till alla anslutna räknare eller till endast valda räknare (från en checklista).

Skicka filer till valda räknare

1. Välj knappen Select Calculators (Välj räknare) i dialogrutan.

2. Markera rutorna intill de räknare som du vill välja.

3. Klicka på Send (Skicka).



Konvertera och skicka bakgrundsbilder
TI-84 Plus CE kan visa bakgrundsbilder och Pic Vars. Dessa variabler visas i
grafområdet.

Anmärkning: All information om bakgrundsbilder gäller också TI-84 Plus C Silver Edition
och TI-83 Premium CE.

Arbeta med bakgrundsbilder

TI Connect™ CE-programvaran konverterar automatiskt en bild du skickar till en
ansluten räknare till en Background Image Var. Din bild kan visas på ett annat sätt än
du förväntar dig på grund av konverteringen till pixeldimensionerna 83 x 133.

Anmärkning: För bästa resultat, redigera din bild så att den är proportionell med 83
x 133 pixlar före konvertering till 83 x 133 pixlar.

Konverteringen till Background Image Var använder 16-bitars färg.

Du kan också ladda upp en Background Image Var till emulatorvyn i TI-84 Plus CE i TI-
SmartView™ CE-programvaran.

Hos TI-84 Plus CE visas en Background Image Var som bakgrund endast i grafområdet.
En bakgrundsbild visas som skalad för MODE-skärminställningarna Full, Horisontell och
Graf-Tabell. Detta bevarar eventuell matematisk modellering som utförts på en
bakgrundsbild. Du kan inte redigera en bakgrundsbild medan du arbetar med
TI-84 Plus CE. Bakgrundsbilder körs från och lagras i Arkivminnet.

Använda arbetsområdet Calculator Explorer (Räknarutforskare) 15



16 Använda arbetsområdet Calculator Explorer (Räknarutforskare)

Skicka en bakgrundsbild till en ansluten räknare
Du kan skicka en bakgrundsbild och visa den i grafområdet hos TI-84 Plus CE.

Obs: All information om bakgrundsbilder gäller även för TI-84 Plus CE-T, TI-84 Plus C
Silver Edition och TI-83 Premium CE.

1. Öppna TI Connect™ CE-programvaran.

2. Välj arbetsområdet Calculator Explorer (Utforska räknare).

3. Anslut TI-84 Plus CE till datorn med kabeln.

4. Sätt på TI-84 Plus CE.

5. Välj den bild som du vill konvertera.

6. Dra bilden till Räknarlistpanelen och håll den över önskad räknare.

7. Släpp musknappen när du ser .
8. Välj ett bildnamn på rullgardinsmenyn (Image0 - Image9). Detta är bildens namn

hos TI-84 Plus CE.

Anmärkning: Bildnamnet du väljer blir bildnamnet hos din räknare. Notera detta
bildnamn (eller gör det till en del av filnamnet i din dator) för identifiering när du
vill skicka eller dela denna fil.

VARNING: Förladdade bilder lagras i Image1 - Image5. Använd andra Image-
nummer för att undvika överskrivning av de förladdade bilderna.

9. Klicka på Send (Skicka).

Obs: Ändra namnet på datorfilen så att du kan identifiera din Image Var senare (bro,
fontän, etc.). Räknarens interna Image#-variabelnamn ändras inte.

Obs: För att spara bakgrundsbilden till din dator, dra bilden från Calculator Explorer
(Utforska räknare) till ditt skrivbord eller till mappen där du vill spara den.

• För att visa din nya bakgrundsbild i grafområdet hos TI-84 Plus CE, tryck påy
., ändra inställningen av Background (Bakgrund) till bilden som du precis

har skickat till räknaren (till exempel Image5) och tryck pås.



Anmärkning: Från räknarens grafskärm kan du också ändra Bakgrunden med det
interaktiva kommandot [draw], BACKGROUND, 1:BackgroundOn.

Dataimport
Med funktionen Dataimport kan du konvertera/skicka kalkylprogramsdata sparade som
csv-datafiler till räknaren som räknarlistor eller matrisfiler.

Du kan ta fram funktionen Dataimport från arbetsområdet Calculator Explorer
(Räknarutforskare).

Viktiga funktioner:

• Skapa (eller ladda ned) ett kalkylark med data.

• Före import, redigera data i din kalkylprogramvara för att endast tillåta numeriska
räknarformat (specificeras nedan) för import till en räknarfil.

Om kalkylprogrammet

• Endast ett kalkylprogram sparat som en CSV-fil (Comma Delimited) (*.csv) kommer
att importeras åt gången via arbetsområdet Calculator Explorer.

• En kalkylprogramfil (csv) kan dras till Calculator Explorer eller importeras via
menyn Actions > Import Data (.csv) to Lists/Matrix....

• Upp till 6 räknarlistor eller 1 matris från kalkylprogramsdata kommer att skickas till
den anslutna räknaren.

Regler för att förbereda kalkylprogrammet för import:

• Alla celler måste innehålla Reella Tal-data som de upplevs på räknaren och ingen
text.

- Komplexa tal stöds inte för dataimport.

• Data måste starta i cell A1

• Listimport: Om räknarlistor önskas:

Använda arbetsområdet Calculator Explorer (Räknarutforskare) 17



18 Använda arbetsområdet Calculator Explorer (Räknarutforskare)

- endast sex kalkylprogramskolumner, A-F, kommer att importeras
- Kolumner kan ha en längd på upp till 999 celler.
- Den första tomma cellen i en kolumn tolkas som slutet på data för den

listimporten

• Matrisimport: om räknarmatris önskas:

- Endast en matris kan importeras från en kalkylprogramsfil.



- Upp till 400 celler kan importeras. (Exempel: rad x kol: 10 x 5 = 50 celler från
radområde 1-10, kolumner A-E.)

- Matrisens dimension i formen (rad x kolumn) kommer att begäras under
importförloppet i Calculator Explorer.

- En tom cell inom den specificerade matrisdimensionen kommer att tolkas som
0.

• Ha inte data i kalkylprogrammet utanför de tillåtna storlekarna för listor eller
matriser enligt ovanstående beskrivning. Annars blir filen ogiltig när du försöker
med en dataimport till Calculator Explorer.

Spara räknarlistor eller matrisfiler

• För att spara skapade räknarfiler till datorn, efter import/sändning till räknare, dra
list- eller matrisfilen från Calculator Explorer till önskad datorplats.

Ta bort räknarfiler
Du kan ta bort data, filer och program från din räknare.

Ta bort filer från räknaren

1. Klicka på filen på panelen Innehåll du vill radera.

2. Tryck på .

Använda arbetsområdet Calculator Explorer (Räknarutforskare) 19



20 Använda arbetsområdet Program Editor (Programeditor)

Använda arbetsområdet Program Editor (Programeditor)
I arbetsområdet Program Editor (Programeditor) kan du arbeta med TI grundläggande
program.



Områden i arbetsområdet Program Editor (Programeditor)

Menyrad - Använd dessa menyer för att hantera filer och program, och för att
få hjälp.

OBS: I arbetsområdet Programeditor kan du bara dra och släppa program
till innehållspanelen.

Verktygsfält - Klicka på dessa ikoner för att Skapa nytt program, Öppna
program, Spara program till dator, Skicka program till ansluten/anslutna
räknare, Ångra eller Gör om och Skjutreglaget för teckenstorlek.

Skapa nytt program.

Öppna program.

Spara program till dator.

Skicka ett program till ansluten/anslutna räknare.
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22 Använda arbetsområdet Program Editor (Programeditor)

Ångra eller Gör om.

Skjutreglage för teckenstorlek för att öka eller minska storleken på
texten i:
• Katalogpanel
• Programeditor

Innehållspanel - Använd denna panel för att skapa, visa och redigera program.

Katalogpanel - Använd denna panel för att välja din typ av räknare och välj
sedan från katalogträdet (efter kategori) för att skapa program.



Syntaxreferenspanel - Använd denna panel för att visa korrekt syntax för varje
kommando tillsammans med obligatoriska och valfria argument.

Skapa ett nytt program
När inga program är öppna visar Innehållspanelen endast ikonerna Nytt program och
Öppna program.

För att skapa ett nytt program

▶ Klicka på ikonen New Program (Nytt
program).

Öppna ett befintligt program

1. Klicka på ikonen Open Program (Öppna
program).

2. Navigera till önskad mapp.
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24 Använda arbetsområdet Program Editor (Programeditor)

3. Klicka på Open (Öppna).

Redigera ett Var Name
Nya programnamn är PROG##. Numren anges i ordningsföljd, till exempel: PROG01,
PROG02.

Ändra ett programnamn

▶ Klicka inuti rutan Var Name och skriv in ett nytt namn på upp till 8 bokstäver eller
siffror (första tecknet får inte vara en siffra).

Skydda ditt program
Med TI Connect™ CE-programvaran kan du förhindra att ditt program redigeras efter
att programmet har skickats till en ansluten räknare.

För att skydda ditt program

▶ Klicka på kryssrutan intill låsikonen.

Spara ett program i din dator
Asterisken i början av ett programnamn indikerar att programmet inte har sparats.

För att spara ett program

1. Klicka på .
2. Navigera till önskad mapp.

3. Klicka på Save (Spara).

Stänga ett program
För att stänga ett program

▶ Klicka på x:et vid programnamnet.



Använda Katalogpanelen
Katalogpanelen innehåller en lista över räknarkommandon, funktioner, variabler och
symboler som du kan använda för att skapa program.

Maximera eller minimera en katalognivå

▶ Klicka på triangeln vid sidan av varje inmatning i Katalogen.

Placera en kataloginmatning i Innehållspanelen

▶ Dra och släpp kataloginmatningen i Innehållspanelen. Detta placerar markören i
programeditorns kommandorad efter att posten släpps.

- ELLER -

▶ Dubbelklicka på kataloginmatningen. Detta klistrar in posten i programeditorn och
fokus förblir på Katalogpanelen för att markera ännu en post. Klicka tillbaka i slutet
av kommandoraden för att fortsätta skriva i editorn.
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Så här undviker du syntaxfel

Använd katalogen över kommandon och symboler för att klistra till editorn. Då undviker
du syntaxfel på grund av felaktig användning av versaler och gemener i kommandon.

Exempel:

Skrev du Eval (eller eval(?

Skrev du sin (eller Sin(?

Katalogträdslistan
klistrar in korrekt
versal/gemen- och
mellanrumsformatterin
g.

Syntaxfel med extra mellanslag

Köra ett program på en räknare

Extra mellanrum kan orsaka syntaxfel när ett program körs på räknaren.



Var finns de extra mellanrummen?
Du kan se de extra mellanrummen i
ditt program med hjälp av TI Connect™
CE Program Editor genom att markera
hela programmet. Extra mellanrum i
slutet av kommandorader ska tas bort
innan du skickar programmet till
räknaren.

Om det finns extra mellanrum när programmet körs i räknaren ska du välja Goto från
syntaxfelskärmen. Då hamnar markören på den programrad där felet förekommer.
Kontrollera raden för korrekt syntax och extra mellanrum i slutet av kommandoraden.

• Flytta markören till slutet av den kommandoraden.

• Ta försiktigt bort extra mellanrum.

OBS: Det finns inget ångra på räknaren.
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När blir kommandona räknarkommandon (token)?

Kommandona blir inte räknarkommandon (token) förrän programmet skickas till
räknaren.

Om det är ett fel när ditt program skickas till eller körs på räknaren, kontrollera om
varje kommando i räknarprogrammets redigeringsläge verkligen är ett kommando-
token.

Hur vet man?

När ett kommando är ett token på räknaren är markören på det första tecknet och
hoppar sedan över kommandot som ett token. Om markören flyttas bokstav för bokstav
genom ett kommando konverteras inte det kommandot. Ta bort och klistra in
kommandot från räknaren.

Kom ihåg: När du matar in ett program direkt i räknaren klistras kommandot eller
funktionen in fullständigt som ett token.

Varning: Vissa räknarkommandon, såsom LEFT, CENTER, RIGHT och FRAC, är ord som du
kan använda i en sträng. Om ett ord som du använder i en sträng är samma som ett
räknarkommando kommer ditt ord att bli ett räknar-token och kan ge fel i ditt program.
Undvik att använda ord eller delar av ord som är samma som TI-Basic-kommandon. Då
undviker du att oavsiktligt göra ett kommando till ett token.

Varning: Språkinställningen i TI Connect™ CE bestämmer hur texten tolkas som ett
kommando-token för räknaren. Öppning av program och sändning tillbaka till räknaren
med TI Connect™ CE på olika språk kan resultera i:

• oönskade kommando-token och/eller

• syntaxfel

Använda Syntaxreferenspanelen
Syntax Reference Panel visar syntaxen för varje inmatning i Katalogen, inklusive
obligatoriska och valfria argument.



HUB- meny för TI-Innovator™ och TI-Innovator™ Rover
Programredigeraren stöder HUB-menyn för TI-Innovator™ för TI-Innovator™ och TI-
Innovator™ Rover-kommandon. HUB-menyn finns i programmenyn i katalogträdet.
Detta HUB-menytillägg till programredigeraren för TI Connect™ CE ger samma HUB-
menyupplevelse som när Appen Hub läses in på CE-räknaren. Se till att alltid använda
de senaste versionerna av CE OS och appen CE Hub.

Se även:

Använda Katalogpanelen
Skicka ett program till en
räknare

Skicka ett program till en räknare
Du kan skicka ett program till en ansluten räknare.

För att skicka ett program till en ansluten räknare

1. Spara programmet om du inte redan har gjort detta.

2. Klicka på .

Använda arbetsområdet Program Editor (Programeditor) 29



30 Använda arbetsområdet Program Editor (Programeditor)

• FILE NAME (Filnamn): Detta kan skilja sig från NAME ON CALCULATOR beroende på
vilket namn du har gett programmet på din dator.

• NAME ON CALCULATOR (Räknarens namn): Välj programnamnet (detta bör vara
standardprogrammet, men du kan ändra programmets namn genom att klicka på
Custom (Anpassat)).

• LOCATION (Plats): Välj huruvida du vill spara programmet i räknarens RAM eller
Archive (Arkiv).

• DESTINATION CALCULATORS (Mottagande räknare): Välj huruvida du vill skicka
programmet till alla anslutna räknare eller till endast valda räknare (från en
checklista).

Skicka program till flera räknare

1. Välj knappen Select Calculators (Välj räknare) i dialogrutan.

2. Markera rutorna intill de räknare som du vill välja.

3. Klicka på Send (Skicka).

Språkinställningar

Om du vill utveckla ett TI-Basic-program i ett annat språk än språkinställningen i din
dators OS kan du starta om TI Connect™ CE i ett annat språk.

1. Välj File > Change Language.

2. Välj språkändring efter att applikationen har startats om.



• QUIT LATER (Avsluta senare) - Behåller det valda språket och TI Connect™ CE
startar med detta språk nästa gång TI Connect™ CE startas.

• QUIT NOW (Avsluta nu) - Stänger lapp. TI Connect ™ CE kommer att lanseras i
detta valda språket nästa gång TI Connect ™ CE lanseras.

• CANCEL (Avbryt) - Ingen språkändring. Datorns OS-språk blir standardinställning.
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Underhålla din räknare
Uppdatera räknarens operativsystem
Med TI Connect™ CE-programvaran kan du ladda ned operativsystem för grafräknare.

Innan du börjar

• Säkerhetskopiera dina räknarfiler (RAM, Archive och Apps).

• Se till att din räknare är påslagen och ordentligt ansluten till datorn.

• Om du har flera räknare i samband med USB-kablar dator, kan OS överföringar ske
till specifika räknare.

Detta kan göras genom att välja specifika räknare i dialogrutan Send.

Varning: Koppla inte loss kabeln under en överföring.

Uppdatera operativsystem hos grafräknare

1. Klicka på Actions > Send OS (Åtgärder > Skicka OS).

2. Navigera till korrekt OS-fil för din räknarmodell som är lagrad i datorn.

3. Klicka på Open (Öppna).

Dialogrutan Skicka OS öppnas.

4. Välj från Destination Räknare:



5. Tryck på Skicka .

TI CE-paketfil – använd en datorfil för att uppdatera din CE-
räknare!
Uppdatera din(a) anslutna CE-räknare med ett steg med hjälp av TI Connect™ CE och
nya TI CE-paketet hämtat från education.ti.com. Ladda alltid ner det senaste TI CE-
paketet från education.ti.com.

Anslut din(a) CE-räknare till TI Connect™ CE. Dra det lämpliga TI CE-paketet till
Calculator Explorer.

• TI-84 Plus CE/CE-T: TI84CEBundle-5.3.1.xxxx.b84

• TI-83 Premium CE: TI83CEBundle-5.3.5.xxxx.b83

TI Connect™ CE uppdaterar din CE OS, alla CE-appar som behöver uppdateras eller
saknas från din räknare samt läser in de 5 förladdade Image Vars till Image1 – Image5.
Denna process kan inte stoppas så se till att spara (dra av) alla dina favoriträknarfiler
med hjälp av TI Connect™ CE Calculator Explorer. Du kan dra dina favoriträknarfiler
tillbaka till räknaren när processen för det nya TI CE-paketet är slutförd.

Dra CE-paketet till Calculator Explorer. Vänta tills hela processen avslutas. Dra inte ur
kabeln under någon filöverföring. Förvänta dig att CE-räknaren startar om innan
överföringen av Image Var och appar. Förvänta dig att CE-räknaren defragmenterar
(omorganiserar minnet) någon gång under processen. Meddelanden visas på TI
Connect CE-fönstret när överföringen startar.

Obs: Förväxla inte TI CE-paketfilen med CE OS och fil för CE-appar, som fortfarande går
att laddas ner separat från education.ti.com. TI CE-paketet innehåller alla de senaste
filerna som du behöver för att uppdatera och återställa din(a) CE-räknare, precis som
om du precis köpt den/dem, och erbjuder ett snabbt sätt att uppdatera klassinställda
CE-räknare.

Viktigt: Om det står "Waiting... (Väntar...)" på CE-räknarskärmen har räknaren förlorat
OS. Detta kan hända om en kabel dras ur från räknaren eller datorn under filöverföring.
Ifall den är ansluten ska du koppla ur de och och sedan återansluta den till datorn. Dra
CE-paketet till Calculator Explorer.

Kom ihåg: Vänta tills hela processen avslutas. Dra inte ur kabeln under någon
filöverföring. Förvänta dig att CE-räknaren startar om innan överföringen av Image Var
och appar. Förvänta dig att CE-räknaren defragmenterar (omorganiserar minnet)
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någon gång under processen. Meddelanden visas på TI Connect CE-fönstret när
överföringen startar.

Du kan behöva upprepa denna process och CE-paketet överför filerna igen. Dra inte ur
kabeln under någon filöverföring.

Se även:

Uppdatera räknarens operativsystem

Skicka filer till anslutna räknare

Inhämta räknarinformation
TI Connect™ CE-programvaran tillhandahåller information om din räknartyp, produkt-ID,
OS-version, RAM, Arkiv, Språk, ROM-version och hårdvaruversion.

Obs: Calculator Information finns endast från Calculator Explorer Work Space.

För att visa räknarinformation

▶ Klicka på View > Calculator Information (Visa > Räknarinformation).

Kompatibilitet med grafräknare
Se handboken TI-84 Plus CE Komma igång för kompatibilitet med grafräknare. Se även
handboken TI-83 Premium CE Komma igång.

Anmärkning: I regel är grafräknarna TI-84 Plus CE kompatibla med andra TI-84 Plus- och
TI-83 Plus-modeller.



Appar, operativsystem och vissa datafiler med numeriska typer som ej stöds delas inte
mellan modeller.

TI-Basic-program kan behöva modifieras för att korrekt visa högupplösta
färgskärmsmodeller.
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Allmän information
Hjälp-funktion online
education.ti.com/eguide

Välj ditt land för ytterligare produktinformation.

Kontakta TI support
education.ti.com/ti-cares

Välj ditt land för teknisk och andra supportresurser.

Service- och garanti-information
education.ti.com/warranty

Välj ditt land för information om längden och villkoren för garanti.

https://education.ti.com/eguide
https://education.ti.com/ti-cares
https://education.ti.com/warranty
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